Focus
Dissolved oxygen in the deep ocean

Grade Level
9-12 (Chemistry/Life Science)

Focus Question
How does dissolved oxygen concentration vary in the deep ocean, and what are some causes of this variation?

Learning Objectives
- Students will discuss the influence of salinity and temperature on dissolved oxygen in seawater.
- Students will identify and discuss at least three factors that may affect the concentration of dissolved oxygen in the ocean.
- Students will analyze dissolved oxygen measurements to prepare a profile of dissolved oxygen concentration in a water column.

Materials
- Copies of CTD Data Inquiry Guide, one copy for each student group.
- Audio-Visual Materials
  - (Optional) video projection or other equipment to show downloaded images (see Learning Procedure, Step 1).

Teaching Time
One or two 45-minute class periods, plus time for student research

Seating Arrangement
Groups of 2-4 students

Maximum Number of Students
30

Key Words
Gulf of Mexico
Cold seep
Lophelia
Deepwater coral
Deepwater Horizon
CTD
Dissolved Oxygen
Oil

Background Information
NOTE: Explanations and procedures in this lesson are written at a level appropriate to professional educators. In presenting and discussing this material with students, educators may need to adapt the language and instructional approach to styles that are best suited to specific student groups.

Around 10:00 pm CDT on April 20, 2010, about 40 miles southeast of the Louisiana coast, a gas explosion occurred on the mobile offshore drilling unit Deepwater Horizon. The explosion killed 11 workers, injured 17 others, ignited an intense fire that burned until the Deepwater Horizon sank 36 hours later, and resulted in a massive release of crude oil that is now considered the greatest environmental disaster in U.S. history. The total volume of oil released into the Gulf of Mexico is estimated to have been 205 million gallons (4.9 million barrels), dwarfing the 11-million-gallon Exxon Valdez spill of 1989. Ecological impacts of the released oil have received extensive media attention, particularly those affecting beaches, marshes, birds, turtles, and marine mammals; but other, less visible, organisms may be affected as well. Many scientists are particularly concerned about the unusual and biologically-rich deep-sea ecosystems on the Gulf of Mexico seafloor.

These ecosystems are often associated with rocky substrates or “hardgrounds.” Most of these hard bottom areas are found in locations called cold seeps where hydrocarbons are seeping through the seafloor. Two types of ecosystems are typically associated with deepwater hardgrounds in the Gulf of Mexico: chemosynthetic communities and deep-sea coral communities. Hydrocarbon seeps may indicate the presence of undiscovered petroleum deposits, so the presence of these ecosystems may indicate potential sites for exploratory drilling and possible development of offshore oil wells. At the same time, these are unique ecosystems whose importance is presently unknown.

For the past four years, NOAA’s Office of Ocean Exploration and Research (OER) has sponsored expeditions to locate and explore deep-sea ecosystems in the Gulf of Mexico. These expeditions were targeted toward broad questions that included:

- Where are cold-seep and deepwater coral communities associated with hard-bottom environments in the deep Gulf of Mexico?
- What organisms are characteristic of cold-seep and deepwater coral communities in the deep Gulf of Mexico?
- What are the relationships between coral communities and artificial and natural substrates?
• What processes control the occurrence and distribution of cold-seep and deepwater coral communities in the Gulf of Mexico?

Working from NOAA Ship Ronald H. Brown, the Lophelia II 2010: Cold Seeps and Deep Reefs Expedition is a continuation of exploration efforts to answer these questions, as well as a new question that has been added to the list:

• What impacts, if any, have occurred in deep-sea communities as a result of the Deepwater Horizon blowout?

This expedition depends heavily upon two key technologies: a remotely operated vehicle (ROV) named Jason II/Medea, which can collect biological samples, photographic images, and physicochemical information from deep-sea ecosystems; and a standard instrument for oceanographic studies known as a CTD.

CTD stands for conductivity, temperature, and depth, and refers to a package of electronic instruments that measure these properties. Conductivity is a measure of how well a solution conducts electricity and is directly related to salinity, which is the concentration of salt and other inorganic compounds in seawater. Salinity is one of the most basic measurements used by ocean scientists. When combined with temperature data, salinity measurements can be used to determine seawater density which is a primary driving force for major ocean currents. Often, CTDs are attached to a much larger metal frame called a rosette, which may hold water-sampling bottles that are used to collect water at different depths, as well as other sensors that can measure additional physical or chemical properties. The Lophelia II 2010: Cold Seeps and Deep Reefs Expedition will use a CTD mounted on the ROV, as well as a larger rosette-mounted CTD carried aboard the NOAA Ship Ronald H. Brown. The CTD aboard the ROV will obtain measurements of salinity, temperature, dissolved oxygen, pH, transmissivity (which provides a measure of suspended particles), and concentration of chlorophyll in 15 deep-sea ecosystem sites. In addition, the ship-based CTD will provide profiles of chemical and physical parameters through the entire water column at 12 sites. Using a crane, the CTD is lowered through the water column then raised again, while instruments on the ship record readings from the CTD’s sensors—sometimes more than 20 times each second. This sampling operation is called a “cast.”

Water column profiles obtained with CTDs have played a major role in the scientific response to the Deepwater Horizon blowout. In early May, scientists working about 5 nautical miles from the blowout site discovered several layers in the water column which showed strong fluorescence (an indication of colored dissolved organic matter such as oil or another substance with similar fluorescent properties), depleted dissolved oxygen, and reduced water clarity (an indication of increased concentration of suspended particles). These anomalies
were found at depths ranging from 700 m to over 1300 m. Similar results were subsequently obtained by other investigations, and numerous ships have been involved with investigating the location and extent of subsurface oil (see [http://www.restorethegulf.gov/release/2010/10/02/subsurface-oil-monitoring-overview](http://www.restorethegulf.gov/release/2010/10/02/subsurface-oil-monitoring-overview)). Much of the data from these investigations are available through the Ship Data page on NOAA’s National Oceanographic Data Center Deepwater Horizon Support Web site ([http://www.nodc.noaa.gov/General/DeepwaterHorizon/ships.html](http://www.nodc.noaa.gov/General/DeepwaterHorizon/ships.html)).

Ship-based CTD casts during the *Lophelia II* 2010: Cold Seeps and Deep Reefs expedition will provide clues about unusual conditions in the water column near deep-sea ecosystems visited by the expedition. This lesson introduces students to techniques that can be used to access and analyze information from CTD studies in the Gulf of Mexico.

**Learning Procedure**

1. To prepare for this lesson:
   - Review procedures and questions on the CTD Data Inquiry Guide.

2. Briefly introduce the *Lophelia II* 2010: Cold Seeps and Deep Reefs Expedition, and describe cold-seep and deepwater coral communities. If desired, show images from the Web page referenced in Step 1. Lead a brief discussion about the Deepwater Horizon blowout. Briefly describe a CTD. Ask students why oceanographers would want to measure conductivity, temperature, and depth. Be sure students understand the relationship between conductivity and salinity, and emphasize that CTDs are often capable of measuring many other parameters in addition to conductivity, temperature, and depth. You may want to use information and/or images from [http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMethods.html](http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMethods.html).

3. Tell students that since the Deepwater Horizon wellhead was capped, many ships have been involved in monitoring subsurface oil. Explain that much of the data from these missions, as well as cruises before the well was capped, is available to the public. Say that their assignment is to compare some of these data, and that the
4. Provide each student group with a copy of the CTD Data Inquiry Guide and ensure that students have access to the Web site referenced in Part B, Step 1.

5. When students have answered questions on the Inquiry Guide, lead a discussion of their results. This discussion should include:

- Dissolved oxygen in the ocean comes from photosynthetic organisms that live in the ocean, and oxygen exchange between the ocean and atmosphere. Note that atmospheric oxygen also comes from photosynthetic organisms.

- The solubility of oxygen in seawater increases as temperature and salinity decrease. So high temperature water can contain less dissolved oxygen than lower temperature water, and water with high salinity can contain less dissolved oxygen than fresh water.

- Dead zones result primarily from algal blooms that may be strengthened by nutrient pollution from large-scale agriculture. When these algae die, their decomposition consumes oxygen. Higher temperatures during the summer also contribute to some extent, since the solubility of oxygen is lower than when temperatures are cooler.

- Students’ plots of Dissolved Oxygen for CTD casts NF70 and NF71 should resemble Figures 5 and 6 respectively.

- Plots of data from cast NF70 show that oxygen is highest near the ocean surface where light for photosynthesis is strongest and oxygen exchange between the ocean and atmosphere is at a maximum. Both processes are progressively weaker as depth increases, and a corresponding decline in dissolved oxygen is seen to depths of about 500 m. Respiration of organisms in this depth
range may also contribute to lower dissolved oxygen. At deeper depths, oxygen gradually increases as lower temperatures increase the solubility of oxygen. The increase gradually stops around 1500 m and remains more or less constant to the maximum depth of the cast at 2000 m.

- Plots of data from cast NF71 differ from NF70 in that there is an initial increase in dissolved oxygen near the surface, and a small decrease at a depth of about 1150 m. The near-surface increase might be due to a combination of photosynthetic activity and slightly lower temperatures in shallow water as compared to surface water. The “spike down” in deep water is unusual, and is similar to observations made near the Deepwater Horizon wellhead shortly after the blowout. If students plot colored dissolved organic matter (CDOM) measurements (Column D) from NF71, they will find a sharp increase at the same depth as the dissolved oxygen anomaly. A working hypothesis to explain these observations is that increased CDOM is due to the presence of oil, and that bacteria degrading deepwater oil suspensions are consuming enough oxygen to cause measurable depletions in the surrounding water.

- Site MC294 is closest (11 km) to the Deepwater Horizon wellhead. Since this site is 1350 m deep, it might be affected by an oceanographic phenomenon similar to the one that appears at 1150 m in data from NF71. If students look in the file NF1013_071_edit_bin_avg.hdr, they will find that cast NF71 took place at 28° 37.07’ North latitude, 88° 26.20’ West longitude; about 14 km from the Deepwater Horizon wellhead.

NOTE: The distance between two points whose latitude and longitude are known can be calculated using the spherical law of cosines formula:

\[
d = \cos (\sin(lat1) \cdot \sin(lat2) + \cos(lat1) \cdot \cos(lat2) \cdot \cos(long2 - long1)) \cdot R
\]

where lat1, long1, lat2, and long2 are the latitude and longitude of points 1 and 2 respectively in radians, d is the distance between the points in km, and R is Earth’s mean radius (6,371 km); latitude and longitude measurements in degrees may be converted to radians by dividing by 180.

This might be an interesting extra credit opportunity for students to develop on their own.
The BRIDGE Connection
www.vims.edu/bridge/ - Click on “Ocean Science Topics” then “Human Activities,” then “Environmental Issues,” then “Pollution” for links to resources about oil spills.

The “Me” Connection
Have students write a brief essay describing how deep-sea ecosystems in the Gulf of Mexico might be of personal significance.

Connections to Other Subjects
Life Science, Social Studies, English/Language Arts, Mathematics

Assessment
Written reports and class discussions provide opportunities for assessment.

Extensions
See http://www.education.noaa.gov/Ocean_and_Coasts/Oil_Spill.html for links to multimedia resources, lessons & activities, data, and background information from NOAA’s Office of Education.

Multimedia Discovery Missions

Other Relevant Lesson Plans from NOAA’s Office of Ocean Exploration and Research
Off Base
(from the Lophelia II 2009 Expedition)
http://oceanexplorer.noaa.gov/explorations/09lophelia/background/edu/media/09offbase.pdf

Focus: pH, buffers, and ocean acidification (Life Science/Chemistry)

Students will define pH and buffer, and explain in general terms the carbonate buffer system of seawater; explain Le Chatelier’s Principle, predict how the carbonate buffer system of seawater will respond to a change in concentration of hydrogen ions; identify how an increase in atmospheric carbon dioxide might affect the pH of the ocean; and discuss how this alteration in pH might affect biological organisms.
A Tale of Deep Corals
(from the Lophelia II 2009 Expedition)
http://oceanexplorer.noaa.gov/explorations/09lophelia/background/edu/media/09tale.pdf

Focus: Deep-sea corals and hydrocarbon seeps (Life Science/Earth Science)

In this activity, students will analyze data on deep-sea corals and evaluate hypotheses to explain why these corals are often found in the vicinity of hydrocarbon seeps.

My Wet Robot
(from the Bonaire 2008: Exploring Coral Reef Sustainability with New Technologies Expedition)
http://oceanexplorer.noaa.gov/explorations/08bonaire/background/edu/media/wetrobot.pdf

Focus: Underwater Robotic Vehicles (Physics/Technology)

Students will discuss the advantages and disadvantages of using underwater robots in scientific explorations, identify key design requirements for a robotic vehicle that is capable of carrying out specific exploration tasks, describe practical approaches to meet identified design requirements, and (optionally) construct a robotic vehicle capable of carrying out an assigned task.

Where's My 'Bot?
(from the Bonaire 2008: Exploring Coral Reef Sustainability with New Technologies Expedition)
http://oceanexplorer.noaa.gov/explorations/08bonaire/background/edu/media/wheresbot.pdf

Focus: Marine Navigation (Earth Science/Mathematics)

In this activity, students will estimate geographic position based on speed and direction of travel and integrate these calculations with GPS data to estimate the set and drift of currents.

Cool Corals
(from the Expedition to the Deep Slope 2007)
http://oceanexplorer.noaa.gov/explorations/07mexico/background/edu/media/corals.pdf

Focus: Biology and ecology of Lophelia corals (Life Science)

In this activity, students will describe the basic morphology of Lophelia corals and explain the significance of these organisms,
interpret preliminary observations on the behavior of *Lophelia* polyps, and infer possible explanations for these observations. Students will also discuss why biological communities associated with *Lophelia* corals are the focus of major worldwide conservation efforts.

**The Benthic Drugstore**  
(from the Cayman Islands Twilight Zone 2007 Expedition)  
http://oceanexplorer.noaa.gov/explorations/07twilightzone/background/edu/media/drugstore.pdf

Focus: Pharmacologically-active chemicals derived from marine invertebrates (Life Science/Chemistry)

Students will identify at least three pharmacologically-active chemicals derived from marine invertebrates, describe the disease-fighting action of at least three pharmacologically-active chemicals derived from marine invertebrates, and infer why sessile marine invertebrates appear to be promising sources of new drugs.

**Watch the Screen!**  
(from the Cayman Islands Twilight Zone 2007 Expedition)  
http://oceanexplorer.noaa.gov/explorations/07twilightzone/background/edu/media/watchscreen.pdf

Focus: Screening natural products for biological activity (Life Science/Chemistry)

Students will explain and carry out a simple process for screening natural products for biological activity, and will be able to infer why organisms such as sessile marine invertebrates appear to be promising sources of new drugs.

**Living in Extreme Environments**  
(from the 2003 Mountains in the Sea Expedition)  
http://oceanexplorer.noaa.gov/explorations/03mountains/background/education/media/mts_extremeenv.pdf

Focus: Biological Sampling Methods (Biological Science)

In this activity, students will understand the use of four methods commonly used by scientists to sample populations; students will understand how to gather, record, and analyze data from a scientific investigation; students will begin to think about what organisms need in order to survive; students will understand the concept of interdependence of organisms.
Chemosynthesis for the Classroom
(from the 2006 Expedition to the Deep Slope)
http://oceanexplorer.noaa.gov/explorations/06mexico/background/edu/gom_06_chemo.pdf

Focus: Chemosynthetic bacteria and succession in chemosynthetic communities (Chemistry/Biology)

In this activity, students will observe the development of chemosynthetic bacterial communities and will recognize that organisms modify their environment in ways that create opportunities for other organisms to thrive. Students will also be able to explain the process of chemosynthesis and the relevance of chemosynthesis to biological communities in the vicinity of cold seeps.

This Life Stinks
(from the 2006 Expedition to the Deep Slope)
http://oceanexplorer.noaa.gov/explorations/06mexico/background/edu/gom_06_stinks.pdf

Focus: Methane-based chemosynthetic processes (Physical Science)

Students will define the process of chemosynthesis, and contrast this process with photosynthesis. Students will also explain the process of methane-based chemosynthesis and explain the relevance of chemosynthesis to biological communities in the vicinity of cold seeps.

Other Resources
The Web links below are provided for informational purposes only. Links outside of Ocean Explorer have been checked at the time of this page’s publication, but the linking sites may become outdated or non-operational over time.


http://oceanexplorer.noaa.gov/edu/development/online_development.html – Online professional development opportunities, including Lessons from the Deep: Exploring the Gulf of Mexico’s Deep-Sea Ecosystems
http://celebrating200years.noaa.gov/edufun/book/welcome.html#book - A free printable book for home and school use introduced in 2004 to celebrate the 200th anniversary of NOAA; nearly 200 pages of lessons focusing on the exploration, understanding, and protection of Earth as a whole system

http://www.piersystem.com/go/site/2931/ – Main Unified Command Deepwater Horizon response site

http://response.restoration.noaa.gov/deepwaterhorizon – NOAA Web site on Deepwater Horizon Oil Spill Response

http://docs.lib.noaa.gov/noaa_documents/NESDIS/NODC/LISD/Central_Library/current_references/current_references_2010_2.pdf – Resources on Oil Spills, Response, and Restoration: a Selected Bibliography; document from NOAA Central Library to aid those seeking information concerning the Deepwater Horizon oil spill in the Gulf of Mexico and information on previous spills and associated remedial actions; includes media products (Web, video, printed and online documents) selected from resources available via the online NOAA Library and Information Network Catalog (NOAALINC)

http://www.gulfallianceeducation.org/ – Extensive list of publications and other resources from the Gulf of Mexico Alliance; click “Gulf States Information & Contacts for BP Oil Spill” to download the Word document

http://www.darrp.noaa.gov/southeast/deepwater_horizon/index.html – Information about damage assessments being conducted by NOAA's Damage Assessment Remediation and Restoration Program

http://www.noaa.gov/sciencemissions/bp油 spill.html – Web page with links to NOAA Science Missions & Data relevant to the Deepwater Horizon/BP Oil Spill

http://www.geoplatform.gov/gulfresponse/ – An online tool developed by NOAA, EPA, U.S. Coast Guard, and the Department of Interior that provides a “one-stop shop” for spill response information

http://www.education.noaa.gov/Ocean_and_Coasts/Oil_Spill.html - “Gulf Oil Spill” Web page from NOAA Office of Education with links to multimedia resources, lessons & activities, data, and background information


**National Science Education Standards**

**Content Standard A: Science As Inquiry**
- Abilities necessary to do scientific inquiry
- Understandings about scientific inquiry

**Content Standard B: Physical Science**
- Structure and properties of matter

**Content Standard C: Life Science**
- Interdependence of organisms

**Content Standard E: Science and Technology**
- Abilities of technological design
- Understandings about science and technology

**Content Standard F: Science in Personal and Social Perspectives**
- Natural resources
- Environmental quality
- Natural and human-induced hazards
- Science and technology in local, national, and global challenges

**Content Standard G: History and Nature of Science**
- Nature of scientific knowledge
Ocean Literacy Essential Principles and Fundamental Concepts

Essential Principle 1.
The Earth has one big ocean with many features.
Fundamental Concept b. An ocean basin’s size, shape and features (such as islands, trenches, mid-ocean ridges, rift valleys) vary due to the movement of Earth’s lithospheric plates. Earth’s highest peaks, deepest valleys and flattest vast plains are all in the ocean.

Essential Principle 4.
The ocean makes Earth habitable.
Fundamental Concept a. Most of the oxygen in the atmosphere originally came from the activities of photosynthetic organisms in the ocean.
Fundamental Concept b. The first life is thought to have started in the ocean. The earliest evidence of life is found in the ocean.

Essential Principle 5.
The ocean supports a great diversity of life and ecosystems.
Fundamental Concept f. Ocean habitats are defined by environmental factors. Due to interactions of abiotic factors such as salinity, temperature, oxygen, pH, light, nutrients, pressure, substrate and circulation, ocean life is not evenly distributed temporally or spatially, i.e., it is “patchy”. Some regions of the ocean support more diverse and abundant life than anywhere on Earth, while much of the ocean is considered a desert.
Fundamental Concept g. There are deep ocean ecosystems that are independent of energy from sunlight and photosynthetic organisms. Hydrothermal vents, submarine hot springs, and methane cold seeps rely only on chemical energy and chemosynthetic organisms to support life.

Essential Principle 6.
The ocean and humans are inextricably interconnected.
Fundamental Concept f. Coastal regions are susceptible to natural hazards (such as tsunamis, hurricanes, cyclones, sea level change, and storm surges).

Essential Principle 7.
The ocean is largely unexplored.
Fundamental Concept a. The ocean is the last and largest unexplored place on Earth—less than 5% of it has been explored. This is the great frontier for the next generation’s explorers and researchers, where they will find great opportunities for inquiry and investigation.
Fundamental Concept b. Understanding the ocean is more than a matter of curiosity. Exploration, inquiry and study are required to better understand ocean systems and processes.
Fundamental Concept d. New technologies, sensors and tools are expanding our ability to explore the ocean. Ocean scientists are relying more and more on satellites, drifters, buoys, subsea observatories and unmanned submersibles.

Fundamental Concept f. Ocean exploration is truly interdisciplinary. It requires close collaboration among biologists, chemists, climatologists, computer programmers, engineers, geologists, meteorologists, and physicists, and new ways of thinking.

Send Us Your Feedback
We value your feedback on this lesson.
Please send your comments to:
oceanexeducation@noaa.gov

For More Information
Paula Keener, Director, Education Programs
NOAA’s Office of Ocean Exploration and Research
Hollings Marine Laboratory
331 Fort Johnson Road, Charleston SC 29412
843.762.8818 843.762.8737 (fax)
paula.keener-chavis@noaa.gov

Acknowledgements
This lesson was developed by Mel Goodwin, PhD, Marine Biologist and Science Writer. Design/layout by Coastal Images Graphic Design, Mt. Pleasant, SC. If reproducing this lesson, please cite NOAA as the source, and provide the following URL: http://oceanexplorer.noaa.gov/
Student Worksheet
CTD Data Inquiry Guide

Part A: Background
1. Where does dissolved oxygen in the ocean come from?
2. How do temperature and salinity affect dissolved oxygen?
3. In some areas of the Gulf of Mexico, dissolved oxygen often is very low during the summer, resulting in “dead zones.” What causes this depletion of dissolved oxygen?

Part B: Analyze!
1. Download a CTD Data File
   a. Open the Ship Data page on NOAA’s National Oceanographic Data Center Deepwater Horizon Support Web site at http://www.nodc.noaa.gov/General/DeepwaterHorizon/ships.html. In the Ship List on the left side of the page, click Nancy Foster. Now you see a summary of data collected aboard NOAA Ship Nancy Foster as part of the response to the Deepwater Horizon blowout. The map on the right shows the ship’s track during the cruise which lasted from July 1 - July 18, 2010. Under Subsurface Oil Monitoring Data, click Processed next to Cruise 01.
   b. A new window opens titled Index of DeepwaterHorizon/Ship/Nancy_Foster/ORR/Cruise_01/processed. Click ctd/.
   c. A new window opens containing separate folders for each CTD cast during Cruise 01. Click on the folder named 2010_0717_NF70/. This folder contains nine files that contain data from CTD cast #70 aboard the Nancy Foster on July 17, 2010 (now you know what the folder name means!).
   d. Click on the file named NF1013_070_edit_bin_avg.asc. Now you have a window full of data! To work with all these numbers, we need to import them into a spreadsheet such as Microsoft Excel®. Right click (control-click on a Macintosh platform) in the window containing the data and save the page as an ASCII text file. Name the file NF70.txt.

2. Import the file into a spreadsheet
   The following instructions are for Microsoft Excel®2008. Other versions of Excel or other spreadsheets will require slightly different procedures. See user documentation for how to import text files and make graphs from these files.
   a. Launch Microsoft Excel® and choose Import... from the File menu.
   b. Click the button next to Text file, then click Import. Navigate to your file named NF70.txt then click Get Data.
   c. A window named Text Import Wizard - Step 1 of 3 will open. Be sure the button next to Fixed width is checked, and the Start import at row box is set to 1. Then click Next.
   d. Now the Text Import Wizard - Step 2 of 3 window shows a preview of how your
data will appear in the spreadsheet. No adjustments should be needed, so click Next.

e. Be sure Column data format is set to General then click Finish. Check the button next to New sheet then click OK. Now you should have a spreadsheet containing the CTD data from cast #70. Before you do anything else, save your spreadsheet!

3. **What do the numbers mean?**
The first row of the spreadsheet identifies the type of data in each column. The abbreviations are:

- **Column A: T090C** – Temperature measurement in degrees C
- **Column B: PrDM** – Pressure measurement in decibars
- **Column C: Sbeox0V** – Actual voltage from the dissolved oxygen sensor (this is converted to normal units for dissolved oxygen and the values are listed in columns N and O)
- **Column D: WetCDOM** – Fluorescence measurement from the colored dissolved organic matter sensor
- **Column E: FlECO-AFL** – Fluorescence measurement from the chlorophyll sensor
- **Columns F, G, H: V1, V2, V3** – Voltage measurements from other sensors; in this case V1 is the same as Column E, V2 is the same as Column C, and V3 is not used
- **Column I: C0S/m** – Conductivity measurement in Siemens per meter
- **Column J: DepSM** – Depth in meters
- **Column K: Sal00** – Salinity in Practical Salinity Units
- **Column L: Density00** – Density in kg per cubic meter
- **Column M: SvCM** – Sound velocity in meters per second
- **Column N Sbeox0Mg/L** – Dissolved oxygen in mg/l
- **Column O: Sbeox0Ml/L** – Dissolved oxygen in ml/l
- **Column P: Flag** – Used to identify measurements that may not be valid

Many more details of this CTD cast are contained in the file NF1013_070_edit_bin_avg.hdr, including the latitude and longitude of the cast location.

4. **Analyze the data**
Plot Oxygen as a function of Depth:

a. Select Columns J and N.
b. Under the Insert menu select Chart... A pop-up menu will appear.
c. In the popup menu, click on the XY (Scatter) tab.
d. Click on the Smooth Lined Scatter button. Now you should have a graph that resembles Figure 1.

Figure 1
5. Oceanographers like to plot CTD data with depth on the y-axis and the
greatest depths at the bottom of the plot, since that is the way we usually
think about a profile of the water column. For an x-y plot, Excel plots the first
column on the x-axis. So, to make an “oceanographer’s plot” we need to re-
arrange the data so that temperature values come before depth values.
a. Copy the depth column to one of the blank columns on the right side of the
spreadsheet.
b. Select the Column J and the new Depth column on the RIGHT.
c. Click on the **Smooth Lined Scatter** button (the **XY (Scatter)** tab should still be
selected). Now you should have a graph that resembles Figure 2.
d. To make the greatest depths appear at the bottom of the plot, double click
on the y-axis. The **Format Axis** window will appear. Click the **Scale** button on
the left side of the window, then check the **Values in Reverse Order** box, then
click **OK**. Now your graph should resemble Figure 3.
e. We need to make four more changes. First, the x-axis is now at the top of
the plot. To fix that, double click the y-axis again and check the **Horizontal
(category) axis crosses at maximum value** box. Then click **OK**. Next, the title of
the graph needs changing: Click on the title, then highlight the text. Type in **Oxygen**. Now remove the legend on the right side of the graph by clicking on
the legend and hitting the **Delete** key. Finally, let’s add labels to the x- and
y-axes: Click inside the plot area, then drag one of the handles on the left
side of the plot toward the center to make space for a label on the y-axis. Make the **Drawing** toolbar visible (select from **Toolbars** in the **View** menu), and select the text tool. Click on the left side of the plot and type **Depth (m)**. Format the text with tools in the Formatting toolbar (select from **Toolbars** in the **View** menu), then drag the green handle on the text box to rotate the text 90 degrees. Right-click (control click on a Macintosh platform) and drag the text box to the desired location. Use the same procedures to label the x-axis **Dissolved Oxygen (mg/l)**. Now your graph should resemble Figure 4.

![Figure 4](image)

6. **According to your plot**, how does dissolved oxygen vary with depth? What factors or processes might explain these results?

7. **Compare with another CTD cast**
   Follow procedures in Step 1 to download data from CTD cast 2010_0717_NF71. Follow procedures in Steps 2 and 5 to plot Oxygen as a function of Depth. How does your graph from cast 2010_0717_NF71 compare with your graph from cast 2010_0717_NF70. What factors or processes might explain these results?
8. Table 1 shows a list of sites scheduled to be investigated during the *Lophelia II* 2010: Cold Seeps and Deep Reefs Expedition. The Deepwater Horizon wellhead is located at 28.7366° North latitude, 88.3872° West longitude. Which of these sites is closest to the blowout location? Could this site be affected by an oceanographic phenomenon similar to the one that appears in data from NF71?

<table>
<thead>
<tr>
<th>Site</th>
<th>Depth (m)</th>
<th>North Latitude</th>
<th>West Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT047</td>
<td>835</td>
<td>27.8802</td>
<td>-89.7888</td>
</tr>
<tr>
<td>GB535</td>
<td>585</td>
<td>27.4274</td>
<td>-93.5854</td>
</tr>
<tr>
<td>GB299</td>
<td>300</td>
<td>27.6865</td>
<td>-92.2296</td>
</tr>
<tr>
<td>GC184</td>
<td>525</td>
<td>27.7493</td>
<td>-91.5077</td>
</tr>
<tr>
<td>GC140</td>
<td>300</td>
<td>27.8103</td>
<td>-91.53768</td>
</tr>
<tr>
<td>GC249</td>
<td>1422</td>
<td>27.1101</td>
<td>-91.166</td>
</tr>
<tr>
<td>MC294</td>
<td>790</td>
<td>27.724</td>
<td>-90.5149</td>
</tr>
<tr>
<td>MC165</td>
<td>1350</td>
<td>28.6758</td>
<td>-88.4788</td>
</tr>
<tr>
<td>MC751</td>
<td>438</td>
<td>28.1937</td>
<td>-89.7987</td>
</tr>
<tr>
<td>MC885</td>
<td>650</td>
<td>28.0646</td>
<td>-89.6951</td>
</tr>
<tr>
<td>VK906</td>
<td>377</td>
<td>29.0696</td>
<td>-88.3772</td>
</tr>
<tr>
<td>VK826</td>
<td>460</td>
<td>29.1564</td>
<td>-88.01503</td>
</tr>
</tbody>
</table>